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Who can do? 
 Fresh Matriculation who are interested to learn 

Matrix and Jewelry Design Software 
 Already working professional who are looking a 

better Prospect in Jewelry Designing 
 People who are working in same domain would 

like to learn latest software of Jewelry Designing. 
 People who would like to get certification in this 

era. 
 

http://www.3deducators.com/
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Course Objectives 

Create interactive images of your Matrix designs for your customers to 
view via email or from your company’s website. These three dimensional, 
photo realistic images provide full control to the viewer; allowing them to 
spin, reposition, zoom in and out, and even change gem or metal materials 
with immediate results! With your design opened in Matrix and a few 
simple clicks using the Matrix Viewer tool, you can create files used to 
share your designs with the world in an exciting new way - and they don’t 
need a 3D program to view it! 

http://www.3deducators.com/
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About the Program Designer & Instructor 

The “PRO-E” Program has been 
designed and will be conducted the 
Senior Engineers who has more than 
Ten years experience in the field of 
Development and Engineering 
Management. 

The Person are Certified where he has 
been providing his services in industry 
for last 12 years and conducting so many 
different session with the PRO-E and 
work or develop the real time 
applications for here and abroad.  

At present, faculty is working in the 
same technology and working as a 
senior position in the renown 
organization, further he is also involved 
in training and development for last 
fifteen years. 

Program Structure 

Other Learning Activities 

No of classes per week 
Duration of each class 
Guided Hours 
Non Guided Hours 
Total Hours  

01 Class  
02 – Hour 
32 Hours 
12 Hours 

48 Hours 
 

Classroom Assignments 
Presentations by Trainees 
Project   
    
  

08 
01 
01 

 

The Training Program will be 
inaugurated by a senior member of  
3DEducators. 

Inauguration 

 

http://www.3deducators.com/
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Create interactive images of your Matrix designs for your customers to 
view via email or from your company’s website. These three dimensional, 
photo realistic images provide full control to the viewer; allowing them to 
spin, reposition, zoom in and out, and even change gem or metal materials 
with immediate results! With your design opened in Matrix and a few 
simple clicks using the Matrix Viewer tool, you can create files used to 
share your designs with the world in an exciting new way - and they don’t 
need a 3D program to view it! 

Matrix Viewers 

That’s right! You can now order your diamonds & gemstones through 
Matrix. Use the Stuller Gem Order Builder to specify the 4 C’s and instantly 
order/update your Stuller account with confidence that Stuller is the 
largest DTC Sight holder and fulfillment house in the USA. 

Stuller Gem Ordering 

Send your model to Stuller for manufacturing directly from the Matrix 
Interface. Build your Matrix model and let Stuller Studio CAD/CAM Services 
take care of the rest. 

Stuller Studio CAD/CAM Services 

http://www.3deducators.com/
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The Chicago Bonus Tools have now been integrated into the Matrix 
interface for ease of use. Each tool can now be found within its’ respective 
menu. 

Bonus Tools Integrated 

Access more tools using the graphic icons within the Matrix Interface. 
Instead of typing the command in the command line, access the tool with 
one simple click of the mouse. 

New Icons/features 

Stuller Gem Ordering:  
That’s right! You can now order your diamonds & gemstones through 
Matrix. Use the Stuller Gem Order Builder to specify the 4 C’s and instantly 
order/update your Stuller account with confidence that Stuller is the 
largest DTC Sight holder and fulfillment house in the USA. 
 
Gem Update:  
Fix pesky broken gems using the Gem Update button. 

Tools Menu 

http://www.3deducators.com/
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Matrix Viewer: 
This new and highly interactive 3D viewer allows customers to view and 
interact with your 3D models outside of the Matrix Software. This tool will 
add a new dimension to the approval process, and also provide a unique 
feature to your website. 

View Menu 

Adjust Closed Surface Seam: 
An oldie but goodie, we now have a button for the Adjust Closed Surface 
Seam function. 

Surface Menu 

Sparkle: 
Add glamour and life to any render with the new Sparkle builder. Send 
your new animated render (with Sparkle’s included!) to your client via 
email or use it on your website.  
 
Movie Maker:  
Sew a series of static images together and make an animated movie. Use 
this comprehensive tool and include a watermark or picture in picture. 
Fade your movie in and out to add a professional touch. This advanced tool 
can be used for marketing or demonstration purposes. 

New Render Tools 

http://www.3deducators.com/
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Stuller Studio CAM Services: 
Manufacturing your Matrix design has never been so easy. Link directly to 
the Stuller Studio Cam Services website from inside the Matrix interface. 

File Menu 

Clear History:  
Clear the history on one or more parts of your model to end the 
relationship between history enabled parts. 

Info & Settings Toolbar 

http://www.3deducators.com/
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Chapter # 1:       Chapter # 2: 

Introduction      Building Shanks & Bands  
 An Introduction to Matrix 6.3   Building Your First Ring 
 The F6 Key and Matrix 6.3    The Ring Rail Tool 
 Tour of a Matrix Builder     The Profile Placer Tool 
 Using Info & Settings Menu    Create your own Profile 
 Using Project Manager     Using Sweep 1 History 
 Project Manager Database     The Outside Rail Tool 
 The Top 11 Buttons      Using Sweep 2 History 
 Using the File Menu      Multi-Rail Sweep History 
 Using the Measure Menu     Profile End Cap 
 A Tour of the Interface         
 History and Matrix 6.3    Adding Basic Gems 
 Modeling in the Viewports     The Gem Loader Tool 
 The Layers Menu      Gem Positioned & MSR 
 Using Master Job Bags    Using Bezel Builder 
 Using the Snaps Menu    Matching Gem Attributes 
 “Cool Display Modes”     Emerald & Baguette Builders 
 Using the View Menu      
 Basic Utilities Menu Tools   Basic Setting Tools 
         Using Head Builder 
         Using “Pull Object to Rail” 
         Saving & Loading Styles 
         Using Heads Library 
         Emerald Profile & Cluster Tools 

Section I: Primary 

 

http://www.3deducators.com/
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Chapter # 3: 
Closed Curve Tools     Open Curve Tools   
 Curve Tools for Basic Design    The Line Command   
 The Circle Command      Arc & Arc Direction   
 The Ellipse Command  
 The Rectangle Command    Open or Closed Curve Tools  
 The Polygon Command     The Polyline Command  
         Interp Curve & Curve Tools  
 
Fixing Problem Curves    Tools to Modify Curves  
 The “Offset” Commands     Rebuild & Fit Commands  
 The Two “Blend” Commands    Eternity Ring Builder  
 The Fillet & Chamfer Tools     Raised Band Builder  
 Using Curve Boolean  
          
Curves on a Surface 
 Extract Isocurve Commands  
 Pullback & Project  
 The Center Line Tool  
 Other Curve Menu Tools  
          

http://www.3deducators.com/
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Chapter # 4:       Chapter # 5: 

Gems from Curves      Builders Menu 
Multiple Gems & Settings    Using Matrix Builders 

 Gems & Objects on a Curve 
 Advanced Cluster Builder    Ring Builders 
 Gems Between 2 Curves     Eternity Ring Builder 
 Building a Baguette Channel   Raised Band Builder 
 Baguette Between 2 Curves 
 The Custom Gem Tool   Design Element Builders 
         Pattern Builder 
Managing Multiple Gems    The Two Knot Builders 
 Using Gem Reporter     Jump Ring & Nautilus Builders 
 Using Gem Guides  
 Using Gem Update    Award-Style Ring Builders 
         Signet Ring Builder 
Managing Multiple Gems    The Award Ring Builder 
 Using Gem Reporter      The Surface Pullback Tool 
 Using Gem Guides  
 Using Gem Update     New Modeling Tools  
         Surface Inset 
Setting Multiple Gems 
 Creating a Prong Layout    Intermediate Tools 
 Prong Editor      The Curve Transform Tool 
          

Section II - Intermediate 

http://www.3deducators.com/
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The Metal Piece Setting  
 The Channel Border Tool     Tools to Mirror Designs 
 The Gem Profile Tool      Mirror Mode & Mirror Shatter 
 
     Gem Cutters         Cutting Tools To Mirror Designs 
 Cutters for 1 or Many Gems    Plane & Cube Cutters 
         Quad Flip Builder 
     Cutting Tools 
 Cut to Finger Rail Tool      Tools Menu Builders 
 Boolean Builder & Booleans    The Ring Resizer Tool 
 
    Tools for use with Booleans 
 Boolean-Related Commands 
 

 

 
          

Chapter # 6:       Chapter # 7: 

   Surfaces & Solids from Curves   Intermediate Gem Tools 
 Build, Edit Surfaces & Solids   Intermediate Gem Tools 
 The “Extrude” Tools 
 The “Pipe” Commands   Pave Tools  
 The Revolve Commands    Creating Simple Pave 
        Using Gem on Surface 
    Creating Surfaces      Using Springs 
 Creating Simple Surfaces    Adding Pave Azures 

         Adding Pave Prongs 
         Prong & Bead on Surface 

         Auto Pave’: Advanced Designs 
         Using “Pave’ Sphere” 

http://www.3deducators.com/
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   Tools to Edit Surfaces & Solids   
  

Cap Planar & Extract Surface  
 The Blend Surface Command 
 Fillet & Chamfer Tools 
 Basic Scale Tools   
 Bend, Twist, Taper, & Shear 
 The Cage & Cage Edit Tools 
 The Polar Array Tool   

Make Downward Facing 
 
       
  

 

Advanced Gem Tools   
  

Gem Control  
 Gem Follow 
 Fillet & Chamfer Tools 

Using “Object to Gem”   
  
 
       
  

 

Chapter # 8:        

Advanced Profile & Rail Tools   Advanced Surface Editing 
  

Advanced Modeling Concepts  Offsetting Surfaces 
 The Profile Sweep Tool   Extend Surface 
 Custom Rail & Related Tools  Rebuild Surface 
 Sweeping Custom Rail Rings  Using Match & Merge  
 Using Profile Merge    Using Unroll Surface 
 Dup Edge & Dup Border    Untrim / Shrink Trimmed Surface 
 Orient 2 & 3 Points     Using Move UVN 
 Using Rotate 3D     Using the Soft Move Tools 
 Curves and CPlanes  
 The Blend Targets Menu 

 

Section III - Advanced 

http://www.3deducators.com/
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Advanced Surface Creation 
 
Sweep 1, 2, & Surface Modeling  

 Using the “Loft” Tool  
 Using Curve Network  
 Using the Patch Command  
 Cross Section Profiles  
 Using the Drape Tool  
 Using Height field from Bitmap 
       
  

 
Chapter # 9:       Chapter # 10: 
  Curve Tools: Objects on a Surface        Using Matrix Art 
 Advanced Design Tools     Matrix Art & Mesh Tools 
 Understanding UV Curves     Using the Layer Menu 
 Adjust Closed Curve Seam Pt.    Using the Picture Menu 
 Adjust Closed Surface Seam    Using the Effects Menu 
 The Divide Curve Command    Using the Sculpt Menu  
 

   Transform: Objects on a Surface        Matrix Art Tools 
 Using the “Flow” Commands         Convert to Bitmap 
 Using “Smart Flow”       
 Using The Array Tools          Utilities Menu Tools 
 The Orient Tools & “Splop”     Show Z Buffer 
          
   Solid: Objects on a Surface    Mesh Tools 
 Boss, Rib, Slab, & Holes    The Mesh Mapper Tool 

         Mesh Reducer 

http://www.3deducators.com/
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     Mesh Utilities 
 

Using Apply Mesh UVN  
Create & Fix Meshes   
      

 Chapter # 11:   
      V-Ray    

Rendering With VRay 
 Using Lights    
 Tools to Enhance Renders 
 Sparkle Builder   

Using Wire Compositor  
Other Settings in Render 
 

   Advanced Rendering 
 

Creating Environments 
Saving User Environments 
Creating Materials  
Saving User Materials 
Rhino & VRay Functions 
Render Effects with Maps 

http://www.3deducators.com/
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DISTANCE NOT MATTER 
 

You can join in the live classes Sessions of 3D EDUCATORS – TRAINERS & 
CONSULTANTS from anywhere of the world. 
 

ONLINE LIVE CLASSES FACILITY AVAILABLE 
 

 Instructor Led Training 
 Real Time Presentations  
 Interactive Classes  
 Complete Notes and Other Stuff shall be provided through our Secure 

Student Login Member’s Area 
 For Online Live Classes, you may please download the Admission Form 

through our website http://www.3deducators.com. Fill it properly and 
attached the required document along with Picture and send back to 
info@3deducators.com with scanned fee submitted voucher in the bank.  

 For Pakistan you may submit the fee at any MCB Branch with the title 
of “3D EDUCATORS-TRAINERS & CONSULTANTS”.  

 If you are outside Pakistan then you may transfer via Bank to Bank or 
any western union, Fast Track, Money Gram or else International 
Transfer Body. 

 After Admission, if you don’t have GMAIL Account then you are 
requested to kindly make one GMAIL Account and shared it 
info@3deducators.com. Then further correspondence shall be made by 
our institute official.  

 Extra Bandwidth Charges shall be incurred. 

 

http://www.3deducators.com/
http://www.3deducators.com/
mailto:info@3deducators.com
mailto:info@3deducators.com
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PRECAUTIONARY MEASURES 
 

 During Classes, you are requested to make sure that you are in isolated 
room, where no noise should be there except your voice.  

 Kindly Switch Off your Cell Phone during the class, because it will 
disturb the quorum of class. 

 If you have taken the admission in the course online lonely, then 
ethically it is recommended and suggested that you alone in the class.  

 Recording of Lectures are not allowed at your end.  

This world is emerging and growing in the 21st Century very rapidly 
because of latest and remarkable technologies and its advancement. Due 
to advancement of technology, we 3D EDUCATORS offer Live Interactive 
class sessions 

3D EDUCATORS believe on Information Technology and its systems. Now 
you can also avail this facility at your home.  

 

 
021-34141329,  0333-2402474 
021-34857148 

 

CONTACT US 

 info@3deducators.com 
http://www.3deducators.com 

 

 
 

Get the Admission Form 
 

MANAGEMENT 
3D EDUCATORS  

 TRAINERS & CONSULTANTS 

 

http://www.3deducators.com/
mailto:info@3deducators.com
http://www.3deducators.com/
http://www.3deducators.com/memberships/admissionform/StudentAdmissionForms.pdf
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TERMS & CONDITIONS 
 

WITHDRAWAL FROM THE CERTIFICATION OR DIPLOMA 
Students are not allowed to withdraw from the CERTIFICATION/DIPLOMA. If a 
student cannot continue the CERTIFICATION his/her fee will be forfeited.  
 
CONDUCT AND DISCIPLINE 
A disciplinary action, leading to rustication, will be taken against students whose 
conduct is found objectionable at any time during the course of study. Reference 
will be made to 3D Educators code of conduct. 
 
EVALUATION AND GRADING 
The performance of students is evaluated through continuous observation of a 
student’s performance in the CERTIFICATION/DIPLOMA – class participation, 
submission of assignments, quizzes and exercises.  
The student will be examined through three hourly exams conducted at the 
midterm and a final exam at the end of the program. Total marks for passing the 
CERTIFICATION/DIPLOMA will be 70 out of a total of 100. 
Students who do not meet the attendance or any other eligibility criteria will not 
be allowed to appear in the final examination. 
 
The following grading plan will be applicable for the CERTIFICATION/DIPLOMA: 
 

A B+ B C+ C F 
87-100 81-86 72-80 66-71 60-65 Below 60 

 
Students who are unable to appear for the final exam are required to submit a 
written application stating the reason for not appearing for the exam. 3D 
Educators reserves the right to approve or deny such applications. If approved, 
the student will be allowed to sit for the exam within one month. Failure to do so, 
the student will be resubmit the examination fee and sit the future schedule 
exam. Without passing of the exams no certification will be awarded. 

http://www.3deducators.com/
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Training Certificate Sample 

http://www.3deducators.com/
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International Certificate of Authorization from IMRTC 
USA 

http://www.3deducators.com/

